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Circuite Integrate Monolitice pentru Microunde 

Proiect 

Tema de proiectare 

Se proiectează circuite pasive realizate în tehnologia prezentată la curs (Plessey). Se foloseşte 

Sonnet pentru simulare electromagnetică şi Microwave Office pentru simulare de circuit. La 

sfârşitul semestrului se predă un material care să descrie componenta implementată, analiza de 

convergenţă, schema echivalentă şi detaliile tehnologice - nr. de straturi/model metal etc. - 

(format hard sau electronic pdf/doc) împreună cu fişierele care implementează proiectul în 

Sonnet (cel mai precis proiect din analiza de convergenţă, proiect funcţional - fişierul _X_.son 

+ subdirectorul corespunzător _X_ din directorul "sondata", versiunea prezentă în laborator, sau 

ultima versiune evaluativă disponibilă online http://www.sonnetsoftware.com/ ) şi Microwave 

Office (NI AWRDE) fişierele *.emp, *.vin şi subdirectoarele din "DATA_SETS" 

corespunzătoare. 

Fiecare temă va conţine dimensiuni fizice pentru următoarele componente: 

 bobină spirală pătrată, celulă standard 

 condensator planar (sandwich) cu poliimidă (PI) 

 condensator planar (sandwich) cu nitrură de siliciu (Si) 

Fiecare student va alege din tema proprie o singură componentă pentru a o analiza, ţinând cont 

de nota maximă pentru fiecare componentă (tabelul următor). 

Nr. Tip componentă Nota 

maximă 

1 Bobină 8 

2 Condensator PI 6 

3 Condensator Si 7 

Tabel 1. Teme de proiectare 

Pentru compensarea notei maxime (eventual) mai mici de 10 se poate beneficia de unul din 

următoarele bonus-uri: 

Nr. Descriere Bonus Detalii 

1 Utilizare structură cu trei straturi (GaAs+PI+aer) 0  

2 Utilizare structură cu cinci straturi (GaAs+Si+PI+Si) +0.5 Fig. 7a 

3 Utilizare structură cu nouă straturi (GaAs+Si+PI+Si) +1 Fig. 7b 

4 Utilizare metal ideal 0  

5 Utilizare model "Normal metal" +0.5 Fig. 2 

6 Utilizare model "Thick metal" (min. 4 nivele) +2 Fig. 3,4 

7 Utilizare model "Dielectric Brick" +1 Fig. 6,7b 

Tabel 2. Punctaj suplimentar 

http://www.sonnetsoftware.com/
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Note:  

 Modele mai complicate presupun creşterea considerabilă a timpului de calcul şi a 

memoriei necesare. 

 Unele combinaţii temă/bonus nu sunt posibile. De exemplu: capacitate pe siliciu cu 

model "Thick metal" pentru metalizări implică automat utilizarea modelului "Dielectric 

Brick", sau utilizare două straturi (GaAs+PI) se poate aplica doar pentru bobină şi 

condensator PI 

 Toate componentele implică utilizarea a două nivele de metalizare (M2 şi M3) şi implică 

apariţia trecerilor între nivele (via-holes) 

Straturile de materiale implicate sunt reprezentate simplificat în figura 1, indicându-se de 

asemenea suprafeţele pe care se depun cele două niveluri de metalizare M2 şi M3 (nitrura de 

siliciu se depune deasupra acestor metalizări pentru a evita conexiuni electrice nedorite). În 

tabelul 3 sunt prezentate caracteristicile materialelor utilizate. 

 
Fig. 1. Straturi dielectrice 

Nr. Material r tan  [S/m] Rsq[mΩ/sq] h[μm] 

1 GaAs 12.85 0.3·10
-3 

  200 

2 Si3N4 7.2 15·10
-3

   0.13 

3 PI 3.4 55·10
-3

   1.8 

4 M2   3.6·10
7
 55 0.5 

5 M3   3.3·10
7
 10 3 

Tabel 3. Caracteristici materiale utilizate 

Pentru descrierea metalizărilor există mai multe nivele de detalii introduse, care sunt 

recompensate prin bonus-uri diferite (tabelul 2). În primul rând modelul utilizat în Sonnet poate 

fi: 

 Metal Ideal (Lossless), pierderi nule, înălţime egală cu 0 

 Modelarea pierderilor (Normal Metal), cu mărimile introduse fiind cele din figura 2: , h 

şi raportul de curenţi între suprafaţa de sus şi cea de jos a conductorului. Pierderile sunt 

modelate prin rezistenţe de suprafaţă, raportul de curenţi depinzând de tipul de linii 

introduse. Pentru linii microstrip acest raport este tipic 1.5 . În structura geometrică 

înălţimea introdusă este 0 (valoarea introdusă în model e utilizată strict la calcularea 

impedanţelor de suprafaţă). 

h GaAs 

h Si 

h PI 

h Si 

M2 

M3 
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 Modelarea pierderilor şi a înălţimii liniei (Thick metal), cu mărimile introduse fiind cele 

din figura 3: , h şi numărul de nivele de metalizare introduse pentru simularea înălţimii. 

În structura geometrică înălţimea introdusă este cea indicată şi Sonnet realizează automat 

secţionarea stratului dielectric de deasupra pentru a introduce efectiv folii metalice în 

structură (fig. 4). Se obţin astfel câteva (NumSheets -1) suprafeţe suplimentare, şi câteva 

straturi suplimentare care permit modelarea mai bună a înălţimii liniei, cu creşterea 

corespunzătoare a timpului de calcul şi a memoriei necesare, ca urmare se recomandă 

creşterea graduală a numărului de nivele (2 - 4 - 6) cu urmărirea necesarului de memorie 

şi cu realizarea unei analize de convergenţă. În această situaţie metalizarea se extinde pe 

verticală şi intră în stratul dielectric de deasupra. 

 
Fig. 2. Modelarea pierderilor (Normal metal model) 

 
Fig. 3. Modelarea grosimii metalizării (thick metal model) 
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Fig. 4. Modelarea grosimii metalizării (4 nivele) 

 
Fig. 5. Geometria reală în circuitul integrat 

Utilizarea modelului "thick metal" oferă apropierea cea mai mare de situaţia reală (fig. 5). 

Suplimentar, înălţimea stratului de pasivizare cu nitrură de siliciu este mai mică decât a 

metalizărilor implicate (0.13μm faţă de 0.5/3μm) ceea ce aduce o dificultate suplimentară la 

modelarea cu precizie a depunerii nitrurii de siliciu pe metalizare. O modelare precisă impune 

introducerea unor straturi suplimentare şi utilizarea modelului "Dielectric Brick". Elementul 

"Dielectric brick" în Sonnet introduce un paralelipiped dintr-un material dielectric în interiorul 

unui alt material dielectric, obligatoriu extins pe întreaga înălţime a stratului dielectric în care se 

realizează introducerea (fig. 6). Introducerea unui bloc dielectric trebuie însoţită de impunerea 

unei secţionări pe verticală a stratului dielectric corespunzător "number of Z-partitions" (în 

meniu, Circuit -> Dielectric Layers -> buton Z-Parts...). Iniţial valoarea este 0 pentru straturile 

"normale", fără blocuri dielectrice, dar trebuie crescut la minim 1 la introducerea unui astfel de 

bloc, cu creşterea corespunzătoare a timpului de calcul şi a memoriei necesare, ca urmare se 

recomandă creşterea graduală a numărului de nivele (1 - 2 etc.) cu urmărirea necesarului de 

memorie şi cu realizarea unei analize de convergenţă.. 
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Fig. 6. Dielectric Brick în Sonnet 

Pentru modelarea nitrurii de siliciu depusă pe metalizare e necesară introducerea suplimentară a 

4 straturi prin împărțirea în trei secțiuni a straturilor de poliimid şi aer (pentru a crea nivelele 

necesare între care să se extindă depunerile de pe metalizare - fig. 7). 

 
Fig. 7. Modelarea pasivizării pe metalizare (5 straturi -> 9 straturi) 

Simulările în Sonnet se realizează între 1 şi 20GHz (corespunzător tehnologiei Plessey) şi se 

obţin pentru utilizarea în analiza de circuit parametrii S pentru dispozitivul analizat. Parametrii S 

se obţin în aplicaţia Response Viewer unde pot fi afişaţi parametrii S, dar exista şi optiunea 

exportării acestor parametri (în meniu, Output > S,Y,Z Parameter File) cu alegerea optiunilor: 

Format = Touchstone, Data Type = De-Embedded, Parameter = S-Param, Complex = Mag-

Angle. 

Note 

 E obligatorie creşterea incrementală a complexităţii modelului ales (nr. de straturi, nr. de 

celule, model metal, introducere bloc dielectric, număr de nivele la metalizări şi în 

h M3 

h Si 

h PI 

h Si 

h M2 

h Si 

h PI 1 = h M2 − h Si 

 

h Si 

h PI 2 = h Si 

 

h PI 3 = h PI − h M2 

 

h a 
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h a 2 = h Si 
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Dielectric  Brick 

h a 3 
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blocurile dielectrice), deoarece modelarea "completă" depăşeşte cu mult resursele de timp 

şi RAM pe care le aveţi la dispoziţie 

 Modelarea componentei se face fără introducerea elementelor suplimentare inevitabile în 

practică, dar care sunt caracterizate de modele suplimentare: trecere M2/M3 pentru 

revenirea pe nivelul de metalizare M3, tranziţii de la linia standard de conexiune 

(12/40μm) la linia utilizată în circuit, etc. (fig. 8,9). 

 E necesară adăugarea opţiunii "Add reference planes" (neutilizată la laborator) pentru a 

asigura obţinerea modelului componentei fără a introduce şi liniile (de lungime variabilă) 

de acces (fig. 8,9). 

 Dimensiunile celulelor standard sunt: 

o bobină: lăţimea traseelor 12μm, spaţiul între trasee 12μm, latura trecerilor 40μm, 

diametru trecere (via) M3-M2 circulară cu diametru 30μm, prima spiră din jurul 

trecerii are latura internă 76μm (fig. 9), linia de acces pe M3 are diverse orientări 

în funcţie de numărul de sferturi de spiră din temă. 

o condensatoare: lăţimea liniilor de acces la armături (M2 şi M3) este de 40μm (fig. 

8) 

 Modelarea se încheie prin obţinerea modelului de circuit pentru componentă. Această 

operaţiune se realizează de mai multe ori pe parcursul realizării proiectului. Analiza de 

convergenţă presupune urmărirea variaţiei unei mărimi numerice importante din 

structură, iar în cazul componentelor simulate această mărime va fi valoarea componentei 

(mărimea principală, fără componentele parazite, L sau C) 

   
Fig. 8. Modelare condensator, plane de referinţă 
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Fig. 9. Modelare bobină, plane de referinţă 

Modelarea în simulatorul de circuit se realizează în Microwave Office (NI AWR Design 

Environment, versiunea 11/32b sau 12/64b). În principiu paşii sunt: 

 modelarea schemei echivalente pentru componentă, prezentată în slide-urile de la curs 

împreună cu relaţiile necesare pentru a calcula valorile elementelor 

 compararea rezultatului (parametri S) cu rezultatele obţinute în Sonnet 

 variaţia valorilor elementelor din schema echivalentă în vederea suprapunerii în banda 

largă (1-20 GHz) a celor două rezultate 

o în cazul alegerii temei cu bobină există o rezonanţă a parametrului S21 la o 

frecvenţă în interiorul benzii tehnologiei (1-20 GHz). Suprapunerea modelelor se 

face numai până la 80-90% din această frecvenţă 

În  NI AWRDE majoritatea comenzilor pot fi introduse din meniu sau utilizând Project Browser 

(prezent in partea stângă a ferestrei - fig. 10). Indicaţiile în continuare sunt prezentate cu 

utilizarea Project Browser. 

   
Fig. 10. Project Browser 

 Paşii pentru implementarea modelării sunt următorii: 

 Introducerea unei scheme: click dreapta pe "Circuit Schematics > New Schematic" 
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 Desenarea schemei: click "Elements" în partea de jos, în tab-ul Elemente se alege 

"Lumped Element" + "Capacitor/Inductor" iar apoi in jumătatea de jos se alege 

componenta ideală (Closed Form)  corespunzătoare IND/CAP şi cu drag/drop se depune 

pe schemă cu left . Right click înainte de a depune componenta implementează funcţia 

rotire. E important să se aleagă componenta ideală şi nu un model care include elemente 

parazite. Schema implementată realizează modelarea separată a elementelor parazite 

 Masa şi porturile se regăsesc în bara de butoane din partea de sus a interfeţei. 

Interconectarea elementelor se face punând cursorul mouse-ului deasupra unui terminal. 

Cursorul se modifică semnalizând poziţionarea corectă, după care cu click se porneşte 

desenarea firelor de legătură. 

o Atenţie: are importanţă poziţionarea corectă a porturilor astfel încât să corespundă 

cu notaţia porturilor în Sonnet, mai ales la schemele asimetrice (bobină şi 

condensator PI). De exemplu în figurile 8, 11 portul 1 este pe M3 iar portul 2 este 

pe M2. 

 
Fig. 11. Desenarea schemei echivalente pentru condensator PI 

 Adăugarea unor ferestre de afişare a rezultatelor: right click "Project Browser -> Graphs 

> New Graph". Se creează grafice pentru S11, S12, S21, S22 

 Se introduce în proiect fişierul cu parametri S obţinut în Sonnet "Project Browser > Data 

Files > Import Data File" cu selecţie "Touchstone files" (potrivit pentru *.s2p) 

 Se ataşează la fiecare grafic mărimile de afişat: "Project Browser > Graphs > X > Add 

Measurement". Se alege "Port Parameters", "S", se selectează porturile corespunzătoare, 

se alege "Data Source Name" (care poate fi schema desenată sau fisierul de date introdus, 

în funcţie de ce se doreşte să se afişeze, sau ambele dacă se doreşte o comparaţie) 

 Specificarea caracteristicilor analizei, frecvenţe. Right click "Project Browser > Project 

Options > Frequencies" Se introduc valorile "Start, Stop, Step" şi se apasă butonul 

"Apply", verificând că opţiunea Replace este selectată. 

o E recomandabil să se respecte valorile indicate la analiza în Sonnet pentru a 

realiza o coincidenţă între punctele din AWRDE şi cele din Sonnet 

 Se simulează schema. Se vizualizează diferenţele între parametrii S calculaţi de Sonnet şi 

cei calculaţi de NI AWRDE pentru schema echivalentă. Valorile iniţiale ale 

componentelor sunt calculate cu relaţiile din curs. 
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Fig. 12. Compararea simulării de circuit cu simularea electromagnetică pentru condensator PI 

 Pentru variaţia parametrilor din schema echivalentă e necesară o analiză de optimizare. 

Primul pas constă în definirea valorilor care trebuie modificate. Lista totală a variabilelor 

prezente în schemă se obţine din meniu: View > Variable Browser. 

 
Fig. 13. Definirea variabilelor şi a intervalului de variaţie 
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 Se selectează mărimile care urmează a fi variate automat (Optimize) sau manual (Tune). 

În cazul optimizării automate este indicat să limităm intervalul de variaţie pentru 

variabile (coloana Constrained) şi să specificăm limitele de variaţie pentru variabile. 

Limitele pot fi introduse ca valori absolute in coloanele Lower şi Upper sau ca variaţie 

relativă faţă de valoarea nominală de pe coloana Value (de exemplu 10% se introduce 

sub forma "10%") sau ca variaţie absolută faţă de valoarea nominală (de exemplu +10 se 

introduce sub forma "10#"). Dacă valoarea introdusă (ex.: 10, 10%, 10#) se introduce în 

coloanele Lower/Upper se completează numai acea coloană (ex.: N+10%N, N-10%N, 

N+10, N-10). Dacă valorile de interval (ex.: 10%, 10#) sunt introduse în colana 

corespunzătoare valorilor nominale Value, se completează automat ambele coloane 

Lower Upper cu o abatere egală faţă de valoarea nominală (absolută sau nominală, ex: 

±10%, ±10). În exemplul din figura 13 la toate variabilele s-a introdus un interval de 

-90%/+300%. 

 
Fig. 14. Definirea ţintei procesului de optimizare 

 Definirea unei ţinte pentru algoritmul de optimizare automată se face: Right click 

"Project Browser > Optimizer Goals" (figura 14). New/Edit Meas permite introducerea 

mărimilor care vor fi controlate în procesul de optimizare. În NI AWRDE există o 

opţiune utilizabilă în cazul temei curente "Port Parameters > SModel"care acceptă ca 

parametri două seturi de parametri S (Data Source Name) şi calculează eroarea/diferenţa 

între cele două seturi, pentru toate porturile implicate, la toate frecvenţele. Condiţiile 

necesare sunt ca cele două seturi de parametri să corespundă aceluiaşi număr de porturi 

(2X2 în cazul nostru) şi să fie aibă acelaşi număr de puncte în frecvenţă determinate (de 

unde recomandarea anterioară de a fixa frecvenţe identice în NI AWRDE şi Sonnet). De 

menţionat că în anumite cazuri acest model de eroare nu dă rezultate corecte astfel încât 

trebuie compusă o condiţie de coincidenţă utilizând SDeltaM (diferenţă de modul), 

SDeltaP (diferenţă de fază) pentru unul sau mai mulţi din parametrii S corespunzători. 

 Se poate defini intervalul de frecvenţe în care se face optimizarea, tipul de condiţie care 

trebuie îndeplinită, se introduce o valoare numerică pentru ţintă. În cazul nostru (figura 

14) e potrivită fixarea unei ţinte egală cu 0 şi o condiţie de egalitate între mărimea 

controlată şi ţintă. De menţionat că în unele cazuri (abatere mare între seturile iniţiale de 
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parametri S) e posibil să apară necesitatea introducerii unor multiple relaţii de tipul Abs 

(SDeltaM) < 1e-3 (sau echivalente). 

 Se porneşte algoritmul de optimizare din meniu: "Simulate > Optimize". Se afişează 

fereastra programului de optimizare din care se poate alege numărul de iteraţii, algoritmul 

utilizat (Random e suficient în acest caz deoarece optimizarea nu durează excesiv de 

mult). Se poate porni/opri optimizarea, se poate salva setul de parametri de la un moment 

dat şi se poate reîncărca unul salvat anterior sau setul iniţial (numai până la închiderea 

ferestrei de optimizare, după aceasta valorile finale sunt trimise în schemă). Se poate 

urmări valoarea erorii instantanee (Cost) şi cum descreşte aceasta în decursul timpului. 

 
Fig. 15. Fereastra programului de optimizare 

 E utilă afişarea în acelaşi timp a ferestrei cu lista variabilelor, deoarece pe acesta se 

semnalează situaţiile în care programul de optimizare a atins limitele impuse de variaţie 

pentru variabile (fundal roşu) sau este foarte aproape (fundal galben), caz în care se 

impune modificarea limitelor respective pentru a putea obţine o optimizare corectă 

(figura 16) 

 
Fig. 16. Atingerea limitelor de variaţie a variabilelor 

 După atingerea unei erori scăzute se poate verifica potrivirea între seturile de parametri S 

şi se poate obţine din schemă valorile finale pentru componente 



12 

 

 
Fig. 17. Rezultatele optimizării pentru condensator PI 

 
Fig. 18. Valorile optimizate din schema echivalentă pentru condensator PI 

Exemplu de proiectare 

Să se proiecteze un condensator planar (sandwich) cu poliimidă cu latura armăturii de X μm. 

Se încearcă obţinerea notei maxime, deci la nota de bază 6p se adaugă bonus-urile pentru 

"Utilizare structură cu nouă straturi" (+1p, Fig. 7b), "Utilizare model Thick metal" (+2p, Fig. 

3,4) şi "Utilizare model Dielectric Brick (+1p, Fig. 6,7b). 

Se desenează structura în Sonnet conform indicaţiilor anterioare. Structura de bază va fi cea 

corespunzătoare complexităţii maxime ţintite (Fig. 7b), fiind relativ uşor de eliminat straturi, 

blocuri dielectrice, modificat model de metal pentru a realiza analize simplificate. 
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O primă alegere care trebuie realizată este cea a dimensiunii celulei, deoarece desenarea se face 

prin nodurile unui grilaj existent. În acest moment trebuie ţinut cont de cum va fi modificată 

celula pe viitor, deoarece la modificarea celulei se schimbă şi grilajul asociat, şi e mai comod ca 

structura desenată să se potrivească şi cu grilajele viitoare, evitând astfel desenarea din nou a 

structurii de fiecare dată. 

Se alege celula cea mai mare preconizată a fi utilizată ca divizor al laturii armăturii şi a altor 

dimensiuni din structură, chiar dacă numerele rezultate nu vor fi tocmai "rotunde". În continuare 

orice înjumătăţire a celulei va păstra desenul ancorat pe grilaj. 

 
Fig. 19. Alegerea dimensiunii maxime a celulei 
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Dacă structura o impune, celulele nu trebuie neapărat să fie pătrate, discuţia fiind similară dar 

separată pe cele două direcţii, apărând două grade de libertate suplimentare  
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Se reaminteşte puterea "magică" a puterilor lui 2 în ceea ce priveşte alegerea unei dimensiuni 

iniţiale. Se recomandă îndeplinirea, dacă e posibil, ca fiecare din valorile întregi ale rapoartelor 
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din relaţiile anterioare (k, l, m, p, q, r, s) să fie o putere a lui 2. În acest caz, dacă alegerea iniţială 

se dovedeşte a fi prea mică, este posibilă dublarea dimensiunii celulei de un număr de ori 

(variabil) cu păstrarea condiţiei de ancorare a desenului structurii pe nodurile grilajului. 
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Regulile amintite creează o serie geometrică pentru dimensiunile celulei, utilizând 2 ca bază. 

Orice număr întreg poate fi folosit ca bază, dar utilizarea unui număr mai mare duce la obţinerea 

unei scăderi a celulei mult prea rapidă care creşte prea brutal memoria şi timpul necesare pentru 

analiză (ex: 1,2,4,8,16… / 1,3,9,27,81…) 

Notă importantă: Sub nici un motiv nu se dezactivează opţiunea Snap (din meniu Tools > Snap 

Setup sau - mai uşor de apăsat din greşeală - din butonul din bară). Dacă nu se poate desena 

dimensiunea dorită pe grilajul curent, e un semn că alegerea iniţială a celulei a fost greşită. 

Pentru schema realizată se alege celula cea mai mare de dimensiune 8μm, pătrată, cu îndeplinirea 

condiţiilor anterioare. Vom putea apoi micşora celula prin înjumătăţire (4μm, 2μm, 1μm, 0.5μm) 

fără a mai fi necesară redesenarea structurii. Se utilizează frecvent comanda View > View 3D 

pentru a verifica poziţionarea corectă a elementelor (Fig. 20 - după direcţia Z scala este 

exagerată pentru observarea detaliilor subţiri). 

 
Fig. 20. Structura desenată: 9 straturi (8 nivele), Thick Metal, Dielectric Brick 

Urmează realizarea unei analize de convergenţă pentru a determina nivelul de detalii necesar de a 

fi introdus în analiză. Mărimea primară de interes pentru dispozitivul simulat este capacitatea 

primară. Pentru fiecare analiză electromagnetică se vor salva parametri S într-un fişier 

Touchstone care va fi folosit în Microwave Office pentru optimizarea schemei echivalente şi 

obţinerea parametrilor din schemă. Valorile calculate cu relațiile din curs pentru modelul 

echivalent (valorile de start din MWO) sunt cele din figura 11: 
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E momentul să menţionăm că ţinta analizelor nu va fi să obţinem exact aceste valori prin 

simulare, deoarece caracteristicile tehnologiei Plessey ar putea să fie puţin diferite de 

caracteristicile menţionate în tabelul 3. 

Investigarea efectului modelării metalizărilor se face pentru o structură cu celula de 4μm, cu 

modelul Thick metal cu un număr variabil de folii metalice (NS = 2,4,8,16), pe o structură fără 

utilizarea blocurilor dielectrice (Si3N4 aplicat pe metalizări) pentru accelerarea analizelor. Vom 

verifica şi situaţia utilizării unor modele mai puţin performante pentru metalizări (NS = 0, 

metalizare ideală - LossLess - sau normală - Normal Metal). Pentru aceste modele, trebuie să 

ţinem cont de dispariţia înălţimii metalizărilor, care nu sunt neglijabile, acest lucru putând fi 

realizat prin eliminarea straturilor de dielectric de înălţime h PI 1 = h M2 − h Si şi h a 1 = h M3 − h Si 

din figura 7b. Deoarece mărimea capacităţii unui condensator planar depinde explicit de distanţa 

dintre armături, în acest mod asigurăm cu aproximaţie aceeaşi înălţime de poliimidă între 

acestea. Rezultatele analizei de convergenţă sunt prezentate în tabelul 4 şi figura 21. 

Nr Cell [μm] NS NZ Mem. [MB] Timp/f [s] C_PRIME [pF] Obs. 

1 4 0 0 8 1 0.829956 0 (LL) 

2 4 0 0 8 1 0.830049 0 (NM) 

3 4 2 0 49 6 0.865465 2 (TM) 

4 4 4 0 94 13 0.865567 4 (TM) 

5 4 8 0 226 42 0.86558 8 (TM) 

6 4 16 0 662 170 0.865632 16 (TM) 

Tabel 4. Analiză de convergenţă, caracteristici metalizări 

 
Fig. 21. Analiză de convergenţă, caracteristici metalizări 

Analiza de convergenţă arată importanţa utilizării modelului "Thick Metal", dar demonstrează de 

asemenea faptul ca un număr de două nivele de metalizare ar fi suficiente pentru structura 
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analizată (cu mai multe nivele apare o variaţie a capacităţii dar nu este esenţială). Vom alege 

totuşi 4 nivele de metalizare pentru a îndeplini condiţiile de obţinere a punctelor bonus. 

Investigarea dimensiunii celulei necesară pentru analiză va fi făcută de asemenea în lipsa 

blocurilor dielectrice aplicate pe metalizări pentru accelerarea analizelor. Rezultatele sunt 

prezentate în tabelul 5 şi figura 22. Se observă că variaţia capacităţii determinate este de ordinul 

0.5% între celula de 8μm şi cea de 0.5μm deci o dimensiune de 8μm ar putea fi suficientă. Totuşi 

celulele fixate în planele de metalizare vor genera secţionare corespunzătoare şi a blocurilor de 

dielectric care vor fi aplicate pe metalizări. Avem anumite informaţii legate de necesităţile de 

memorie şi timp de calcul şi o indicaţie relativ la valoarea aproximativă a celulei care trebuie 

utilizată (~4μm) dar o decizie definitivă trebuie luată cu structura completă (inclusiv cu blocurile 

de dielectric) 

Nr Cell [μm] NS NZ Mem. [MB] Timp/f [s] C_PRIME [pF] 

1 8 4 0 46 6 0.86475 

2 4 4 0 94 13 0.865567 

3 2 4 0 196 42 0.867043 

4 1 4 0 422 175 0.867043 

5 0.5 4 0 910 795 0.869494 

Tabel 5. Analiză de convergenţă, dimensiune celulă, fără "Dielectric Brick" 

 
Fig. 22. Analiză de convergenţă, dimensiune celulă, fără "Dielectric Brick" 

Investigarea efectului partiţionării pe verticală a straturilor de dielectric care vor conţine blocuri 

dintr-un alt dielectric (model "Dielectric Brick") se face cu o dimensiune a celulei mare (8μm), 

pentru a nu genera analize excesiv de lungi şi consum excesiv de mare de memorie. Rezultatele 

sunt prezentate în tabelul 6 şi figura 23. Se observă importanţa deosebită pe care o are 

introducerea blocurilor de dielectric (în principal stratul depus pe metalizarea M2 care joacă rol 

de dielectric dintre armăturile condensatorului), în schimb pentru această structură particulară 

partiţionarea suplimentară pe verticală a blocului în 2 sau mai multe nivele nu aduce deloc 
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modificarea rezultatelor. Deci blocurile de dielectric vor trebui să apară dar nu este necesar să fie 

partiţionate suplimentar, e suficient Z Parts = 1. 

Nr Cell [μm] NS NZ Mem. [MB] Timp/f [s] C_PRIME [pF] Obs. 

1 8 4 0 46 6 0.86475 fără Dielectric Brick 

2 8 4 1 150 13 0.907305  

3 8 4 2 272 22 0.907305  

4 8 4 4 629 60 0.907305  

Tabel 6. Analiză de convergenţă, partiţionare pe verticală a "Dielectric Brick" (Z Parts) 

 
Fig. 23. Analiză de convergenţă, partiţionare pe verticală a "Dielectric Brick" (Z Parts) 

În acest moment se cunoaște că e nevoie de metalizare "Thick Metal" cu 4 nivele de metalizare, 

blocuri de dielectric fără secţionare suplimentară (Z Parts = 1) şi o dimensiune a celulei de 

ordinul 8-4-2μm. O analiză de convergenţă pe structura completă (figura 20) este necesară pentru 

o decizie finală asupra dimensiunii celulei. Rezultatele unei astfel de analize sunt prezentate în 

tabelul 7 şi figura 24. Se utilizează mărimile (Num. Sheets şi Z Parts) determinate anterior şi se 

variază dimensiunea celulei. Variaţia se opreşte la celulă pătrată cu latura de 2μm, necesarul de 

memorie pentru a realiza analiza cu o celulă de 1μm fiind prea mare pentru a efectua calculele 

(61565MB). Variaţia capacităţii primare de la 8 la 2μm este foarte mică (0.24%) deci inclusiv 

analiza cu celulă de 8μm oferă valoarea acestei capacităţi cu precizia dorită. 

Nr Cell [μm] NS NZ Mem. [MB] Timp/f [s] C_PRIME [pF] 

1 8 4 1 150 13 0.907305 

2 4 4 1 724 80 0.908093 

3 2 4 1 5540 2012 0.909546 

Tabel 7. Analiză de convergenţă, dimensiune celulă, cu "Dielectric Brick" 
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Fig. 24. Analiză de convergenţă, dimensiune celulă, cu "Dielectric Brick" 

Putem păstra ca analiză finală pe cea corespunzătoare celulei de 2μm deoarece: 

 a fost deja realizată 

 chiar dacă precizia de determinare a capacităţii nu a fost prea mult îmbunătăţită, un efect 

se poate observa la nivelul elementelor parazite din schemă. 

Reprezentarea valorilor elementelor parazite pentru toate analizele menţionate anterior sunt 

prezentate în tabelul 8 şi figura 25. 

Nr Cell [μm] NS NZ LM2 LM3 CM2 CM3 R 

1 8 4 0 0.0409116 0.0371284 0.058781 0.002339 1.63628 

2 4 4 0 0.0406743 0.036595 0.058749 0.002655 1.65111 

3 2 4 0 0.0395224 0.037366 0.059294 0.002296 1.65123 

4 1 4 0 0.0395224 0.037366 0.059294 0.002296 1.65123 

5 4 0 0 0.0389316 0.0401411 0.05995 0.001309 1.69544 

6 4 0 0 0.040071 0.0389618 0.059496 0.001479 1.5165 

7 4 0 0 0.0394318 0.039994 0.059819 0.001427 1.79109 

8 4 0 0 0.0401877 0.0392315 0.059493 0.001481 1.60394 

9 4 2 0 0.0406282 0.036834 0.059127 0.002275 1.65311 

10 4 8 0 0.0396937 0.0375932 0.059304 0.002124 1.6635 

11 4 16 0 0.0400478 0.0372841 0.059154 0.00227 1.68848 

12 8 4 1 0.0416706 0.0363008 0.058382 0.002731 1.5549 

13 4 4 1 0.0412981 0.0359557 0.058656 0.002748 1.56621 

14 2 4 1 0.0395643 0.0373039 0.059328 0.002272 1.56837 

15 8 4 2 0.0416706 0.0363008 0.058382 0.002731 1.5549 

16 8 4 4 0.0416706 0.0363008 0.058382 0.002731 1.5549 

17 0.5 4 0 0.0401386 0.0366658 0.059027 0.002665 1.66789 

Tabel 8. Analiză de convergenţă, valori elemente parazite 
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Fig. 25. Analiză de convergenţă, valori elemente parazite 

Se observă că valorile elementelor parazite sunt consistente între analize pentru elementele 

reactive, cu excepţia pierderilor în structură caracterizate de rezistenţa serie, a cărei valori depind 

destul de mult de modelarea pierderilor prin metalizări şi de prezenţa pasivizărilor de Si3N4 

aplicate pe metalizări (reprezentare pe axa secundară din dreapta în fig. 25). Mai ales valoarea 

rezistenţei beneficiază de micşorarea celulei la 2μm (index 14 în tabelul 8), rezistenţa crescând 

cu 0.84% faţă de analiza cu 8μm celulă. 

Schema echivalentă finală este cea din figura 26. 

  
Fig. 26. Schemă echivalentă finală, condensator PI, latura X μm 

Note finale 

 Pentru interpretarea timpului necesar pentru analiză şi scalarea acestui exemplu la 

sistemul de calcul propriu: analizele au fost realizate pe un sistem cu două 

microprocesoare fizice X5450 @ 3.00GHz, fiecare microprocesor având 4 nuclee fizice 

distincte. Fiecare din cele 8 nuclee a fost folosit în proporţie de 100% pe parcursul 

analizelor. Memoria fizică prezentă: FB-DDR2, 32GB @ 333MHz, sistem de operare 

Windows 7, 64 biţi. 

 Optimizările în Microwave Office au fost realizate folosind metoda "Gradient 

Optimization", Maximum Iterations:50000, Convergence Tolerance:1e-7, Step Size:1e-5. 

Valorile obţinute nu sunt mai precise (în limita atinsă la analize: 1%) şi nu justifică 
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obligatoriu alegerea acestei metode pentru optimizare. A fost aleasă deoarece spre 

deosebire de utilizarea analizei "Random (Local)" rezultatele sunt repetabile (fără 

implicarea numerelor aleatorii). În general se poate utiliza fără probleme "Random 

(Local)". 

 Majoritatea timpului total de analiză a fost folosit pentru cele două analize cu necesar de 

memorie ridicat, ca urmare recomandarea de a realiza majoritatea analizelor de 

convergenţă pe modele simplificate la maxim oferă un câştig de timp destul de ridicat. În 

exemplul prezentat se observă că la investigarea unui parametru (C, NS, NZ) ceilalţi doi 

sunt reduşi la minimul posibil. 

 Respectarea iniţială a indicaţiilor cu privire la alegerea dimensiunilor celulei în funcţie de 

dimensiunile fizice din circuit şi relativ, pe cât posibil, la puterile lui 2, reduce extrem de 

mult timpul consumat cu desenarea schemei pentru multiplele structuri din analiza de 

convergenţă. 

 Simulatorul din Sonnet are prevăzută funcţionalitatea de rulare automată, succesivă a mai 

multor proiecte (fig. 27 - butonul Batch List). Se pot salva mai multe proiecte fără a 

realiza şi simularea (diverse dimensiuni de celulă, număr de straturi, de nivele de 

metalizare etc.), iar cu "Add Project" se pot adăuga în listă, chiar şi în timp ce un alt 

proiect este analizat. Acest lucru oferă posibilitatea de a folosi timpul în care calculatorul 

simulează un proiect pentru a desena un altul şi a-l adăuga la listă ş.a.m.d. (! util mai ales 

dacă simulatorul nu reuşeşte să folosească 100% toate procesoare existente) 

 Informaţiile despre Memorie/Timp se pot obţine din simulator > butonul "Timing Info" 

sau după simulare, din orice program din suita Sonnet din meniu: "Project > View Log > 

Timing Info" 

 
Fig. 27. Simulator Sonnet em, listă de proiecte (Batch List) 

 


